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How to Use 
this Book

Double-click Press the left mouse button two times quickly.
Right-click Press the right mouse button once.
Shift + click Press and hold Shift while pressing the left 

mouse button once.
Ctrl + Shift + click Press and hold both Ctrl and Shift while 

pressing the left mouse button once.
Ctrl + drag Press and hold Ctrl while you clicking and 

dragging the mouse.

Select File/Properties Click the File menu, then click Properties.
Select File/New/Folder Click the File menu, click New, then click Folder.
Select Tools/Options/Edit Click the Tools menu, click Options, then click 

the Edit tab in the Options dialog box.

Select File/Properties Click the File menu, then click Properties.
Select File/New/Folder Click the File menu, click New, then click Folder.
Select Tools/Options/Edit Click the Tools menu, click Options, then click 

the Edit tab in the Options dialog box.

Using the Mouse

Using the Keyboard

Working with Menus

Due to the small format of our books, we sometimes must
sacrifice a little clarity for space. So, before you dive into
the tips, take a quick look at the table below and then check
out the nerdy guides on the next page. That's all you need
to know to get started.

Windows 2000 Tips
This icon marks tips that work
identically in Windows 2000.
Many tips without this icon will
also work in Windows 2000,
but with slight variations.
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Really 
Easy Tips

Kenneth

Fairly 
Easy Tips

Shagg

Fun 
Tips

Shelli

Cool 
Tips

Guy Martini

Long 
Tips

Mr. Nester

Hard 
Tips

Professor
Lester

Kenneth will show 
you the tips that are
easy to use and easy
to remember. Even if
you’re an advanced
Word user, give these
tips a try. There are
quite possibly a few
you don’t know.

Shagg turns up on
tips that are easy to
do, but not always
easy to remember.
He’ll do his best to
help you remember
them, man.

Look for Guy Martini
if you want the
coolest, most likely
to save you time,
tips! (Unfortunately,
you’ll have to put 
up with him to learn
these tricks!)

Some tips are long.
Some are annoying.
And some don't 
always work. Mr.
Nester will let you 
know which tips 
require a bit of time
and a lot of patience!

If you’re new to Word,
you might want to try
Professor Lester’s tips
after you have a little
more experience. He
appears on the more
difficult, confusing or
rarely-used tips.

Shelli appears on
tips that aren't 
necessarily necessary.
They’re little tidbits of
information that are
just fun to know.

Your 
Guides

We’re not just pretty faces. We’re your guides!
Who says learning software has to be boring? We use these six nerdy
characters to help you find the tips that match your level of experience.
They make the tips easy to remember, interesting and fun to use.
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1 TASK BAR & START MENU
Start Menu | Taskbar | Quick Launch Toolbar

12 THE DESKTOP, BEYOND WALLPAPER
Show Desktop | Desktop Icons | Text and Graphic Scraps 
20 SCREEN SAVERS & DESKTOP THEMES

Screen Savers | Desktop Themes
23 CUSTOMIZING THE START MENU

Start Menu Items | Pinning Items to Start Menu | Startup Folder
27 MULTIPLE USERS

Logging In | Welcome Screen | User Accounts | My Documents | Sharing Files
33 EXPLORING WINDOWS EXPLORER

Opening Windows Explorer | Viewing Folders | Navigating Folders | Subfolders
Path Statements | Mapping Drives | The Explorer Bar

44 MAKING FOLDERS AND PUTTING STUFF IN THEM
Creating Folders | Renaming Files & Folders | Compressed Folders | Print a List of Files & Folders

52 GOT SOME FAVORITES?
Displaying & Hiding Favorites | Creating Folders

55 VIEWING FILES IN WINDOWS EXPLORER
Details View | Sorting Files | Column Labels | File Extensions | Thumbnails View | Contact Sheet

63 SELECTING FILES WITH WINDOWS EXPLORER
Selecting Sequential Files | Selecting Random Files | Selecting Groups of Files | Single-clicking Files | File Size

72 COPYING & MOVING FILES IN WINDOWS EXPLORER
Right-dragging Files | Dragging Files | Undo | Copy & Paste Files | SendTo List 

80 WHERE, OH, WHERE DID MY LITTLE FILE GO?
Finding Files | Separate Windows | Search by Date Modified | Deleting Large Files 

Using Wildcards | Saving Searches | Opening Files | File Types
91 THE RECYCLE BIN

Deleting Files | Permanently Deleting Files | Restoring Deleted Files | Emptying the Recycle Bin 
96 REMOVABLE MEDIA & FLYING DISKS

Floppies | Defining CDs & DVDs | Copying Files to CD | Digital Cameras & Scanners
Putting Files on Floppies | Erasing Floppies | Duplicating Floppies

110 WINDOWS SHORTCUTS YOU GOTTA KNOW
Cut, Copy & Paste | Undos | Switching between Programs & Documents | Closing Programs & Documents

Minimize & Maximize | Selecting with the Keyboard | Toolbar Tricks | Getting Help | Dialog Boxes

Contents



129 PRINT THE SCREEN
Print Screen | Alt + Print Screen | Monitor Resolution 

133 ZOOMIN’ AND SCROLLIN’
Traditional Scrolling | Scroll Wheel Scrolling | Zooming | Scroll Wheel Settings

138 THE CONTROL PANEL
Opening Control Panels | Run Dialog Box | Calculator | Swapping Mouse Buttons | Sound Scheme

144 LOADING & USING FONTS
Windows Fonts | Installing Fonts | Removing Fonts | Free Fonts | Character Map

149 SOUND, VIDEO & YOU
Speaker Volume | Sound Recorder | Windows Media Player

156 PRINTING
Printing | Default Printer | Printing Multiple Files | Installing Printers | Postscript® | EPS Files

164 USING WORDPAD
Opening Wordpad | Multiple Documents | Selecting | Wordpad Shortcuts

169 PAINTING (SORT OF) WITH PAINT
Opening Paint | Zooming | Colors | Drawing Tools | Duplicating | Sizing | Wallpaper

179 USING NOTEPAD
HTML Files | Searching | Headers & Footers | Journal | Date & Time | Salvaging a Corrupt Document

185 INSTALLING AND REMOVING
Installing Software | Restore Points | Uninstalling & Re-installing | Hardware Wizard | Dual Monitors

191 INTERNET EXPLORER
Opening Internet Explorer | Opening Linked Page | Full Screen | History | Adding Links | Stock Tickers

198 COMMUNICATIONS
Troubleshooting Modems | Viewing an IP Address | Troubleshooting Web Access 

203 MAKING WINDOWS ACCESSIBLE
Accessibility Options | StickyKeys | FilterKeys | ToggleKeys | High Contrast | Magnifier

210 START ME UP
Startup Folder | Boot Options | Booting off CD | Skip the Windows Login Screen

216 TROUBLESHOOTING
Laptop on Batteries | Frozen Program | Older Programs | Video Problems | Temp Files | Disk Space | Windows Help

MSINFO32 | System Configuration | My Network Places | System Folders | System Files | Automatic Update
INDEX
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Start menu
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Start
menu

#1

Ta s k  B a r  &  S t a r t  M e n u

Here’s a quick 
way to display 
the Start menu.
Press 

If you don’t have a
Windows key on
your keyboard,  just
press Ctrl + Esc or get
another keyboard.

2000
COMPATIBLE



#2

run
programs

Ta s k  B a r  &  S t a r t  M e n u
See t ip :  #1

Press (or Ctrl + Esc), press P until All Programs
highlights, press Enter, then press the first letter of the
program name until it highlights. Press Enter.

You can start almost
any Windows program
with just the keyboard.

I renamed the programs I use with a
number at the beginning (1 Adobe
Photoshop, 2 Word, 3 Excel), then
pinned them to the top of the Start
menu. (Right-click the program, select
Pin tto SStart mmenu.) Now, to open a
program, I just press , then press 
1 or 2 or 3.

2000
COMPATIBLE



Ta s k  B a r  &  S t a r t  M e n u

date
and
time 

#3 Changing the date
and time is easy.

Changing the time and date is so easy, in fact,
that I often change the time before saving a
file. That way, when I give the file to someone
else, it appears that I was working when I was
actually playing golf. Before changing it back, I
visit wwwwww..ttiimmee..oorrgg to set the time precisely. 

Double-click the taskbar clock

Rest your pointer on 
the time to see the date.

2000
COMPATIBLE



Ta s k  B a r  &  S t a r t  M e n u

#4

move
the

taskbar

Want to move the
taskbar? Unlock it,
then start dragging.
Right-click the taskbar, deselect Lock
the Taskbar, then click and drag a
blank area of the taskbar to one of 
the other three edges of the screen.

Drag the top edge
to size the taskbar.

You can even make the Taskbar
bigger or smaller.  Just click and
drag the top edge of the taskbar
until it’s as big as you want it or
until it disappears.  I wish I could
make me bigger.



Ta s k  B a r  &  S t a r t  M e n u
See t ips :  #1,  112

#5

Auto-hide
the

Taskbar

The Taskbar: 
Use it; Don’t use it. 
Use it; Don’t use it. 
Right-click a blank area of the Taskbar,
select Properties, then select Auto-
hide… Click OK. 

Now the Taskbar only appears when 
I move my mouse to the bottom of the
screen. Because I press AAlltt + TTaabb + TTaabb
to switch between programs and 
(or CCttrrll + EEsscc) to display the SSttaarrtt
menu, I rarely use the silly Taskbar.

2000
COMPATIBLE



Taskbar
grouping

Ta s k  B a r  &  S t a r t  M e n u

#6 Crowded Taskbar? The
Taskbar starts grouping.
Documents open in the same program may
be grouped under a single button. Click the
button, then click a document to access it.
Right-click the button, then select Close
Group to close all open documents.

I turned that grouping thing off and so can you.
Right-click a blank area of the Taskbar, select
PPrrooppeerrttiieess, then deselect GGrroouupp ssiimmiillaarr ttaasskkbbaarr
bbuuttttoonnss. At least now I know how many pro-
grams and documents I have open, and I don’t
have to click and read a list to access one. 

Down arrow indicates
multiple documents



Ta s k  B a r  &  S t a r t  M e n u
See t ip :  #8

#7

Quick
Launch

What happened
to the ol’ Quick
Launch toolbar?
It’s now hidden by default. To
unhide it, right-click a blank area
of the Taskbar, then select
Toolbars/Quick Launch. Click
any item on the toolbar to open it.

The Quick Launch toolbar is invaluable.
You can drag programs onto it from the
Start menu or files and folders from
Windows Explorer ( + E). Hey
Microsoft. When it’s hidden by default, 
you can’t do any of the above.

Quick Launch
toolbar



Quick
Launch
tricks

Ta s k  B a r  &  S t a r t  M e n u
See t ips :  #7,  12

#8 What else can you do with
the Quick Launch toolbar?
To Do this
Hide/show the Right-click a blank area of the Taskbar, then 
toolbar select Toolbars/Quick Launch.
Reorder buttons Click and drag the buttons along the toolbar.
Resize the toolbar Click and drag the dotted lines to the right 

of the toolbar. No dotted lines? Unlock the 
Taskbar. Right-click the Taskbar, then 
deselect Lock the Taskbar. 

Float the toolbar Click and drag the toolbar by the dotted lines 
to the left of the toolbar onto the Desktop. 

Re-attach the toolbar Click and drag the toolbar onto the Taskbar.

Does anyone actually “float” the Quick Launch 
toolbar? You can only float it if you can see the
Desktop ( + DD), and you can only use it if you
can see the Desktop. I thought the point of the Quick
Launch toolbar is to have quick, one-click access to
documents and programs you use frequently.

Drag the 
dotted lines

to resize



Desktop
on the
Taskbar#9

Right-click a blank area 
of the taskbar, then select
Toolbars/Desktop.

Want to see a list 
of all items on your
Desktop? Add a 
folder to the taskbar.

If you do this, the word “Desktop” will show
up on the right end of the Taskbar. When you
wanna see a list of the stuff on your Desktop,
click the next to Desktop. If you just click
the word Desktop, you’ll look like a doofus.

Desktop folder 
on taskbar

Ta s k  B a r  &  S t a r t  M e n u
See t ips :  #5,  10,  11

2000
COMPATIBLE



folders on
the

taskbar

Ta s k  B a r  &  S t a r t  M e n u
See t ip :  #9

#10
[1] Right-click a blank area of the taskbar, then 

select Toolbars/New Toolbar. Select the folder you
want, or type a Web address with http:// at the
beginning (http://www.nerdybooks.com). Click OK. 

[2] Drag the left edge of the toolbar to resize the folder.
[3] Click the or double-click the folder name to 

display the folder contents.

Add folders and Web
addresses to the taskbar.

Right-click a blank area of the Taskbar, then select
TToooollbbaarrss. See your new toolbar with a check next 
to it? You might think, hmmmm, I guess I’ll deselect
it since I don’t need it today, then select it again
when I need it. Guess again. Once you’ve deselected
it, it’s gone from the list and you have to add it again.

Folder on taskbar

2000
COMPATIBLE

http://www.nerdybooks.com


Ta s k  B a r  &  S t a r t  M e n u
See t ip :  #4

#11
Notification

areaHide those annoying, 
little icons on the right
end of the taskbar.
[1] Right-click a blank area of the taskbar, 

then select Properties. 
[2] Select Hide inactive icons, then click

the Customize button.
[3] Select an item on the left, then select 

a behavior on the right. Click OK twice.

Finally, I can get all that junk out of the
way! On the rare occasion I want to see
the icons, I click the round arrow button
to the left of the clock. The Notification
area expands to show them.

Notification area with 
all icons displayed

Notification area 
with all icons hidden

Click this arrow 
to show or hide 
the icons



The 
Desktop, 
Beyond
Wallpaper There’s more 

to the Desktop
than changing 
the wallpaper? 
Cool!
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show
the

Desktop  

T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r  
See t ips :  #9,  13,  230

#12 Got a key? 
Minimize everything
and show the Desktop.
Press + D

You can also click the Show
Desktop icon on the Quick
Launch toolbar.  To go back to the
document you were working on,
press + D or click the again.

2000
COMPATIBLE



what
else?

T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r

#13 While we’re at it, 
what are all the 
shortcuts?
To Press
Display the Start menu
Display System Properties + Break
Display the Desktop + D
Open Windows Explorer + E
Search for Files and Folders + F
Search for Computers + Ctrl + F
Open Help and Support + F1
Login as a different user (XP only) + L
Minimize all Windows + M
Undo Minimize All + Shift + M
Open the Run dialog box + R

Most keyboards have another weird
key, the Application key .  Use it
instead of right-clicking something to
display the shortcut menu.  It doesn’t
always work, though.

2000
COMPATIBLE



Desktop
shortcuts

T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r
See t ips :  #12,  33

#14 Want quick access to 
a file or folder? Add 
an icon to your Desktop.
In Windows Explorer ( + E) or any
program’s Save or Open dialog box,
right-click the file or folder, then select
Send To/Desktop (create shortcut).

Shortcut
icons have a
small arrow

Creating shortcuts to files is way too easy...
now my Desktop is covered with icons. To
use an icon, I press + D to show the
Desktop, press the first let ter of the icon’s
name until it highlights, then press Enter. 
To delete an icon (not the actual file), I
press Delete. I guess I should press Delete
more often...

2000
COMPATIBLE



Desktop
cleanup

T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r
See t ip :  #12

#15 Too many icons on
your Desktop? Run
Desktop Cleanup.
Right-click the Desktop, then select
Properties. Click the Desktop tab,
then click Customize Desktop.
Click Clean Desktop Now, then
follow the wizard.

Desktop Cleanup doesn’t actually get rid of
icons, it puts them in a folder on your Desktop
called Unused DDesktop SShortcuts. If only
Windows had a Dirty Clothes Cleanup button
or a Dirty Dishes Cleanup button or a...



T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r
See t ips :  #7,  8 ,  12

#16
shortcut’s
shortcut

[1] Right-click the Internet Explorer icon on
the Start menu, the Quick Launch toolbar
(to the right of the Start button) or the
Desktop, then select Properties.

[2] In the Shortcut key box, type i. Windows
will append Ctrl + Alt. Click OK.

Of course, Internet Explorer is not the only
program that can have a shortcut. I start AAcctt
with CCttrrll + AAlltt + AA, Outlook with CCttrrll + AAlltt + OO,
and QuickBooks with CCttrrll + AAlltt + QQ. I figure
this saves me at least 8.5 seconds!

Want to start Internet
Explorer by pressing 
Ctrl + Alt + I? Assign
a shortcut key.

2000
COMPATIBLE



standard
icons

T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r
See t ip :  #12

#17 If you want to add
back the traditional
Desktop icons...

In previous versions of
Windows, if you didn’t
want the icons you
couldn’t delete them,
Now, if you want them
you can’t find them!

[1] Right-click the Desktop, then select
Properties.

[2] Click the Desktop tab, then click
Customize Desktop.

[3] Select any of the top 4 check boxes 
(My Documents, My Network Places, 
My Computer, Internet Explorer), then 
click OK twice.



scrap
your
text

T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r
See t ips :  #12,  19,  110

#18 Use the same text
over and over again?
Create text scraps.
[1] Make a folder on your Desktop: right-click 

the Desktop, select New/Folder, type a 
name (Scraps), then press Enter.

[2] In Word, Wordpad or any program that 
supports scraps, select your text, then copy 
(Ctrl + C). If your program doesn’t support 
scraps, paste your text into Word or Wordpad 
first, then select the text again and copy.

[3] Show the Desktop ( + D), double-click 
the folder, then paste (Ctrl + V).

[4] To use a scrap, open the Scraps folder on the 
Desktop, select the scrap, then copy (Ctrl + C). 
Open any program that supports scraps and 
paste (Ctrl + V).

I use text scraps when I
need to type my 6 line
address, my 3 cell phone
numbers, my 4 email
addresses, and my fan
club Web address. That
way I can quickly paste
this crucial information
everywhere.

2000
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T h e  D e s k t o p ,  B e y o n d  Wa l l p a p e r
See t ips :  #12,  18,  110

#19

graphic
scraps

Use the same graphics
over and over again?
Create graphic scraps.
[1] Make a folder on your Desktop: right-click 

the Desktop, select New/Folder, type a name
(Scraps), then press Enter.

[2] In any Windows program, select the graphic, 
then copy (Ctrl + C). 

[3] In Word or WordPad, create a new document, 
then paste the graphic (Ctrl + V).

[4] Select all (Ctrl + A), then copy the graphic 
again (Ctrl + C). 

[5] Show the Desktop ( + D), double-click 
the folder, then paste (Ctrl + V).

To use a graphic scrap, select the
scrap in your Desktop folder, copy,
then paste it into any program that
supports scraps. I have scraps for
my award logos, signatures, etc.

2000
COMPATIBLE



Recycle Bin 91-95
Scraps, graphic and text 18, 19
Screen savers 20, 21
Shortcuts 14, 17, 24, 25
Showing, Hiding 8, 12, 13
Stock ticker, adding to 197
Themes 22
Unused Desktop Shortcuts folder 15

Dialog boxes
Buttons, selecting 125
Check boxes, selecting 125
Copying image of 130
Desktop shortcuts, creating from 14
Drop-down lists, opening 125
Folders, Creating 45
Help and Support 124
My Places bar, adding to 128
Resizing 119
Shortcut keys 125
Tabs, selecting 125
Tools menu 127
Views, cycling through 127
Windows Explorer, opening from 34
See also Files, Folders

Digital cameras 101, 102
DirectX 223
Disk Cleanup 225
Explorer (See Internet Explorer, Windows
Explorer)
FTP sites 201
Favorites 52-54
Files

Compressing 50
Cut, Copy and Paste 72-79, 103, 126
Corrupt, opening in Notepad 184
Deleting 91, 126
Details, viewing 55-59
Extensions, hidden 59
Filmstrip view 61

Accessibility Options
FilterKeys, using/settings 205
High Contrast, using/settings 207
Magnifier, using/settings 209
MouseKeys, using/settings 208
Opening 203
StickyKeys, using/settings 204
ToggleKeys, using/settings 206

Address Book 139
Application key 13
Automatic Update 233, 235
CD (See Removable media)
Calculator 139, 141
Character map 139, 148
Clock 3
Control Panel

Accessibility Options 203-209
Hardware, adding new 189
Laptops, Power Schemes 217
Mouse, button assignments 137, 142
Opening settings 138
Printers 157, 159-161
Scanners and Cameras Wizard 102
Screen resolution 132
Shortcuts, adding to Start menu 140
Sounds 143

Cut, Copy, Paste 110
DVD (See Removable media)
Date and Time 3
Desktop

Adding contents to Taskbar 9
Clean Desktop Wizard 15
Folders, adding to 18
Links, adding to 196
Maximizing 13
Minimizing 12, 13

Hidden 59
Moving 72-75
Naming, Renaming 49, 126
New, creating in 48, 168
Opening 87-90
Pasting 76, 77, 126
Printing 51, 62, 156, 158, 162, 163
Restoring deleted 93
Saving 104, 115, 117, 127, 168
Searching for 13, 80-87
Selecting 63-71
Sharing 32
Sorting 56-58
Temp files, deleting 224
See also My Computer, Searching,
Windows Explorer

Floppy disks 96, 103-108
Folders

Deleting 91-93
Details, viewing 55-59
Adding to Favorites 53
Adding to SendTo list 79
Collapsing, Expanding 38, 39
Compressed 50
Cycling through 37
Hidden 59
My Documents

Default folder, changing 31
New, creating 44, 45
Opening/Exploring 34, 36
Previous folder, selecting 40
Printing list of 51
Renaming 46, 47
Restoring deleted 93
Searching for 13
Sharing 32
See also My Computer, Searching,
Windows Explorer

Fonts
Downloading from Web 147

Index



Extended characters 148
Installing 145
List of 138, 144
Removing 146

Hardware
Add Hardware Wizard 189
Digital cameras 101, 102
DirectX troubleshooting 223
Help and Support 226
Modems 189, 198, 199
Monitors, using dual 190
Mouse 137, 138, 142, 208
Printers 138, 157, 159-161
Scanners and Cameras Wizard 102
System information 227
System performance settings 222
Troubleshooting 216-235
Video cards and drivers 190, 221

Help and Support
Dialog boxes 124
Programs 123
Troubleshooting 226, 227
Windows XP 13, 123, 226

Internet Explorer
Assigning shortcut key to 16
Back one page 193
Cycling through open 191
FTP sites not responding 201
Favorites 52-54
Forward one page 193
Full screen, viewing 193
HTML documents 179
History 194
Homepage, changing 195
Links 10, 192, 196
Opening 16, 191
Route, tracing packet 202
Stock ticker, adding to Desktop 197
TCP/IP info, displaying 200

Toolbars, Auto-hiding 193
Web pages

Accessing 193, 195
Not responding 201
Response time 202

LAN (Local Area Network) settings 200
Laptops

Battery life, extending 216
Power Schemes 217

Links 10, 196
Login (See Settings, Users)
Mac disks (See Removable media)
Menus 120
Minesweeper 139
Modems 189, 198, 199
Monitors 190
Mouse

Button assignments 137, 142
Cursor, moving with keyboard 208
Opening settings 138
Scrolling 134
Zooming with 136

My Computer
Full screen view 35
My Documents 31
Opening Windows Explorer from 34
Selecting files 63-71
Sharing files and folders 32
See also Files, Folders, Searching,
Windows Explorer

My Documents 31
My Network Places 42, 229
Notebooks (See Laptops, Settings)
Notepad

Date, inserting 183
Footers, Headers 181
Log file, creating 182
Opening 139, 179

Corrupt documents in 184
Searching for text 180
Time, inserting 183

Notification Area 11
Paint 131, 139, 169-178
Passwords 215, 219
Path statements 41, 59
Plug-and-Play devices 102, 189
PostScript ® 162
Print Screen 129-132
Printing 156-163

Contact sheet of images 62
Default printer, changing 157
.eps (Encapsulated PostScript),
converting files to 163
From Windows Explorer 158
Installing printers 159, 160
List of files & folders 51
Multiple files in mult. programs 158
Offline 161
PostScript ®, converting files to 162

Programs
Closing 114, 116, 218
Cycling through open 112
Dialog boxes 124-128
Frozen, shutting down 218
Grouping multiple items on Taskbar 6
Help and Support 123, 124
Installing 185
Menu items, selecting 120
Not responding 218
Opening 2, 139
Program Compatibility Wizard 220
Running as different User 30
Scrolling 133-135
Shortcut keys, assigning to 16
Shortcuts 7, 8, 14, 17, 23-26
Shutting down Windows XP 117
Sizing 118, 119



Toolbars 121, 122
Uninstalling 187
Zooming 136

Quick Launch toolbar
Hiding/showing 8
Floating 8
Links, adding to 196
Re-attaching 8
Resizing 8
Shortcuts 7, 8, 24, 25, 164

Recycle Bin
Capacity 95
Bypassing 92
Deleting files & folders 91, 92
Emptying 94
Restoring deleted files & folders 93
Sending to 91

Registry editor 139
Removable media

CD 96-98, 100
CD-RW 99
Capacity comparison 96
Card readers 101
DVD 96, 97
Digital cameras 101, 102
Floppy disks 96, 103-108
Macintosh disks 109
Zip® disks 96

Resolution (screen) 132
Run dialog box 13, 139, 195
Scanners and Cameras Wizard 102
Scraps, Graphic and Text 18, 19
Screen savers

Downloading from Web 21
Slide shows, creating 20

Scroll bars
Automatic scroll 135
With mouse wheel 134
With scroll bars 133

Searching
For Computers 13
For Files 13, 80-87

By date 82
By name 80
By size 83
By word or phrase 85
In separate window 81, 82
Opening files 87-90
Saving searches 86
Wildcards 84

For Folders 13
See also Files, Folders, Windows

Explorer
SendTo list

Adding folders to 79
Using SendTo 79, 90

Shared Documents folder 32
Shortcut keys

Application key 13
Assigning to programs 16
In dialog boxes 125
Windows key 13
See also Windows key

Shortcut menus 13
Shortcuts

Control Panel, adding to 140
Desktop 14, 17, 24
Quick Launch toolbar 7-8, 24-25
Start menu 23-25
Startup folder, adding to 26

Software
Installing, Uninstalling 185, 187
System Restore 186

Solitaire 139
Sound Recorder 139, 150
Sounds 143
Start menu

Displaying 1, 13

Links, adding to 196
Opening programs from 2
Opening Windows Explorer from 34
Pictures, changing for Users 29
Shortcuts see Shortcuts
See also Taskbar

Startup options
Login screen, bypassing 215
Options menu 212, 213
Passwords 215, 219
Sounds 143
Startup folder

Adding programs to 26
Bypassing on startup 26
Cleaning up 210
Location of 26

Startup screen, remove animation 211
Startup using installation CD 214

System configuration files
Creating 228
Editing 179

System folders
Description of 230
Replacing 232
Restoring 231

System information 13, 227
System Restore 186, 222
TCP/IP info 200
Task Manager 218, 219
Taskbar

Auto-hide 5
Clock 3
Date and Time 3
Folders, adding to 10

With Desktop contents 9
Grouping items 6
Hiding/showing 5
Hiding/showing inactive icons 11
Links, adding to 10



Moving/dragging 4
Notification Area 11
Quick Launch toolbar 7, 8, 24, 25
Re-sizing 4
Unlocking 4
Web pages, accessing from 195

Toolbars
Anchoring 122
Auto-hiding, in Internet Explorer 193
Buttons 121, 122
Displaying 121
Floating 122
Moving 122

Troubleshooting
Automatic Update 233, 235
DirectX troubleshooting 223
Disk Cleanup 225
Error Reporting, turning off 234
Help and Support 226
Laptops 216, 217
My Network Places 229
Program Compatibility Wizard 220
System configuration files

Creating 228
Editing 179

System crashing 221
System folders 230-232
System information 227
System Restore 186, 222
Task Manager 218, 219
Temp files, deleting 224
See also Hardware

Users
Accounts 30
Disabling Welcome screen 28
Fast User Switching option 27
Log off account 219
Login as different 13, 27
Pictures, changing 29

Running programs as different 30
Video cards 190
Video drivers 221
Volume Control 139, 149
Wallpaper 178
Web pages

Accessing 193, 195, 202
Links 10, 192, 196
Not responding 201
Route, tracing packet 202
Stock ticker, adding to Desktop 197
TCP/IP info, displaying 200
See also Internet Explorer

Welcome screen
Disabling 28
Pictures, changing for Users 29
See also Users, Settings

Windows Explorer
Copying 72-79
Deleting files & folders 91-93
Details, viewing 55-59
Explorer Bar, displaying 43
Favorites 52-54
Files, creating from 48
Filmstrip view 61
Folders see Folders
Full screen view 35
Mapping network drives 42
Moving 72-76
My Documents 31
Opening 7, 13, 33, 34
Opening files 87-90
Pasting 76, 77
Recycle Bin 91-95
Removable media 96-109
Searching 13, 80-87
Selecting files & folders 63-71
SendTo list 79, 90
Sharing files & folders 32

Slide show, viewing as 61
Sorting files 56-58
Thumbnails view 60, 61
Undo steps 46, 73, 74
Web pages, accessing from 195
See also Files, Folders, Searching

Windows key 13
Windows Media Player

Full mode, toggling 155
Opening 139, 151
Operating 153
Playlists, creating 152
Skins 154, 155

Windows Movie Maker 139
Windows Tour 139
Windows XP

Automatic Update 233, 235
Error Reporting, turning off 234
Help and Support 13, 123, 139, 226
Login screen, bypassing 215
Passwords 215, 219
Product ID 188
Program Compatibility Wizard 220
Re-installing 188
Restarting 219
Shutting down 117, 219
Sounds 143
Starting up 210-215
Startup Options menu 212, 213
Start. screen, remove animation 211
Startup folder 26 210
Startup using installation CD 214
Tour 139
Welcome screen 28, 29
See also Troubleshooting

WordPad 139, 164-168
Zip® disks (See Removable media)
Zooming 136
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